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1
General Description of Equipment under Test

1.1 Applicant

Name: Nice S.p.A.
Address: via Pezza Alta, 13
Country: 31046 Rustigne di Oderzo (TV) — Italy

1.2 Manufacturer

Name: Nice S.p.A.
Address: via Pezza Alta, 13
Country: 31046 Rustigné di Oderzo (TV) — Italy

1.3 Equipment classification
According to definition 15.3 (0) is a intentional Radiator operating within the Bands:

so it shall fulfil provisions of 47CFR Part 15 Subpart C — international radiators — and
Section 15.209.

According to definition 15.3 (z) is a unintentional Radiator:

So it shall fulfil provisions of 47CFR Part 15 Subpart B — Unintentional radiator and section
15.107 and 15.109.
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1.4 Basic Description of equipment under test

Parameters

Value

Type of equipment:

LPD transmitter

Model: P1/U, P1S/U, P6/U, P6S/U
FCC ID: PMLERAP

Trade Name: Nice

Data cable: -

Telecom cable:

Power supply type:

internal battery

AC power input cable:

DC power input cable:

3Vdc with internal battery 2 x type AAA

Model

Description
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1.5 Feature of equipment under test

Parameters

Power specification

3Vdc (Two internal battery Type AAA)

Operating frequency:

433.92MHz

Maximum RF output power:

78.45dBuV/m at 3m (peak 81.95dBuVv/m) P6/U
74.46dBuV/m at 3m (peak 77.96dBuVv/m) P1/U
77.05dBuV/m at 3m (peak 80.55dBuVv/m) P6S/U
76.45dBuV/m at 3m (peak 79.95dBuVv/m) P1S/U

Occupied Bandwidth

40.9kHz at 99% (worst case)
354kHz at -20dBc (worst case)

Emission Designator (ITU):

40K9A1D

Modulation:

AM (OOK)

Channel spacing:

no channel spacing

Antenna: integral
Rx Sensitivity: none
Main SW identification: none

Main HW board
identification:

PCB nr. SB300A3

Peripherals included (for
system application):

Interfaces:
Integrated interfaces

AC adapter:

none

none

none

none
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2
Test configuration of equipment under test

2.1 Environmental conditions

Test conditions Measured
Ambient temperature: 20 + 25°C
Relative humidity: 50 + 60%
Atmospheric pressure: 900 + 1010mb

2.2  Description of support equipment

Equipment Manufacturer Model
Artificial finger for transmit Nice none
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2.3 Interface identification and connection diagram of test system
Power supply DC / AC
«— Signal / Control
Antenna <+—» EUT
¢—» Telecommunication
Enclosure
# Interface Description Maximum length Ref. Document
1 | Enclosure - 150 x 50 x 20 mm -
2 | AC mains power input none none none
3 | DC power port Two battery type AA none none
4 | Signal / control port none none none
5 | Antenna port none none none
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3
Operation of equipment under test

3.1 Operating test conditions

# Description

1 | transmission

2 | standby
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4
Tests identification and result
CFR47 Title Operating Result
Part 15 condition
Section
15.203 Antenna requirements not applicable
15.247 (b)(4)(i)
15.207 (a) Conduced emission not applicable -
15.209 (a) (f) Radiated emission #1 PASS
#2
15.231 (a) Timing of the transmitter #1 PASS
15.231 (a) Transmit behaviour after releasing the #1 PASS
TX-button
15.231 (b) Radiated output power #1 PASS
15.35 (c) Typical pulse train of a signal #1 PASS
15.231 (b) Compliance with the limit of FCC #1 PASS
#2
15.231 (b) Spurious emission - radiated #1 PASS
15.231 (c) Occupied bandwidth #1 PASS

4.1 Methods of measurement

All compliance measurements have been carried out using the procedures described in the
standard ANSI C63.4-2003 (excluding sub-par. 4.1.5.2, 5.7.9 and 14) and Section 15.31 of
CFRA47 Part 15 — Subpart A (General).

4.2 Frequency range investigated

a) conduced emission tests: from 9kHz to 30MHz.
b) Radiated emission tests: from 150kHz to tenth harmonic of fundamental.
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5

Tests
5.1 Radiated emission
Specify:
Base standard: | 47CFR Part 15 Section 15.209

1) The EUT was placed on turntable which is 0,8m above the ground plane.

2) The turntable shall rotate from 0° to 360° degrees to determine the position of maximum emission level.

3) The EUT is positioned 3m away from the receiving antenna which varied from 1 to 4m to find the highest
emission.

4) The measurements were made with the detector set to PEAK and AVERAGE amplitude within a bandwidth
of 100kHz below 1000MHz and 1MHz above 1000MHz.

5) The receiving antenna was positioned in both horizontal and vertical polarization.

6) The measurements with Quasi-Peak detector, below 1000MHz are performed only for frequencies for which
the Peak values are > (Q.P. limit — 6dB).

Test Requirements:

Test Setup: ANSI C63.4
Test facility: Anechoic chamber
Test distance: 3m
Limits for radiated disturbances: 15.209 (a)
Frequrncy range: 10kHz to 6GHz
IF badwidth (below 150kHz): 200Hz
IF bandwidth (below 30MHz): 9kHz
IF badwidth (below 1000MHZz): 120kHz
IF badwidth (above 1000MHZz): 1MHz
EMC class: B
Limits @:
Fr?ﬁﬂi&?cy Field Strength (uzV/m) Measurement distance (m)
0,0009 - 0,490 2400/F(kHz) 300
0,490 — 1,750 24000/F(kHz) 30
1,750 - 30 30 30
30 - 88 100 30
88 -216 150 3
216 - 960 200 3
above 960 500 3

Note: @ to convert the measuring distance from 3m to 300m and 30m to 300m a correction factor from
40dB/decade was used

Test Data.:

Port under test Operating condition Result
Enclosure #1,2 Complies
Comments:

the results on this report are related to the worst case when the product was tested on three axes (X, Y, Z)
there are no emissions below 30MHz
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Transmission
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Standby
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Transmission

Agilent Spectrum Analyzer - Swept SA
Q| = o M ol |

i ALIGH AUTOD 03:50:23 PM May 15, 2014
Marker 1 2.990000000000 GHz Avg Type: Log-Pur Woaaure at Mk
PNO: Fast —»— 1rig:Free Run AvglHold: --/100
IEGain:Low Atten: 6 dB Ext Gain: 35.00 dB Measure at
Mkr1 3 GHz Marker
Ref 58.99 dBHV/m 40.883 dBuV/m |
Trace 1 Pass M Measure at Mkr
Window»
Freq 2.990 00 GHz [On, Left]
1 Peak 40.65 dBpV/im S e |
2 Quasi Peak 29.68 dBpV/m
3 EMI Avg 29.68 dBpV/m Detectors»
i |
BW &
Avg Type»
Autocoupled

Start 1.000 GHz

Stop 3.000 GHz
Res BW 3.0 MHz VBW 50 MHz Sweep 1.000 ms (1001 pts)

STATUS

IMSG

Agilent Spectrum Analyzer - Swept SA

T e Goaes | ; ALTGH AUTO 03:51:37 P May 15, 2014 M £ Mk
Marker 1 6.000000000000 GHz Aug Type: Log-Pur 1 il
Trig: Free Run Avg|Hold: 1100
IFGain:Low Atten: 6 dB Ext Gain: 35.00 4B Measure at
Mkr1 6 GHZ Marker
Ref 58.99 dBpV/m 49.530 dBpVJ’m ||
Trace 1 Pass i} Measure at Mkr
) Window»
Freq 6.000 00 GHz [On, Left]
1 Peak 46.83 dBUVim ||
f| 2 Quasi Peak 35.87 dBpV/m
] EN‘II Avg 35.87 dBpV/im Detectors»>
| e |
BW &
Avg Typer
Autocoupled

Start 3.000 GHz

Stop 6.000 GHz
Res BW 3.0 MHz VBW 50 MHz Sweep 5.000 ms (1001 pts)
IMSG STATUS €3 LO Unlaocked
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5.2 Timing of the transmitter

Specify:

Base standard: | CFR47 Part 15 Section 15.231 (a)

Unless otherwise specified, e.g. Section 15.225 (b), when the radiated emission limits are expressed in term of
the average value of the emission, and pulsed operation is employed, the measurement field strength shall be
determined by averaging over one complete pulse train, including blanking intervals, as long as the pulse train
does not exceed 0,1 seconds. As an alternative (provided the transmitter operates for longer than 0,1 seconds)
or in cases where the pulse exceeds 0,1 seconds, the measured field strength shall be determined from the
average absolute voltage during a 0,1 second interval strength shall be submitted with any application fro
certification or shall be retained in the measurement data file for equipment subjected to notification or
verification.

Test requirements:

Test Setup: CFRA47 Part 15 Section 15.35 (c)
RBW: 1MHz

VBW: 3MHz

Test Data:

Timing of the transmitter: 132ms (total period)

Transmit button pressed shorted than: -

Pulse train length: -

ON Time: 65*1.5ms + 1.5ms = 66.5ms (worst case with all bit at 1)
OFF Time: -

DC: (66.5ms/100ms) = 0.665 (worst case with all bit at 1)
Correction: 20*l0g(0.665) = -3.5dB

Comments:

See technical file.

TOTAL PERIOD : T = 132 ms

FRAME PERIOD : TF = 114 ms

PAUSE : TP = 18ms

START BIT : TS = 15ms

SINGLE BIT TBIT= 1.5ms

IMPULSE TYPE “0” : TON = 0.5ms, TOFF=1.0ms
IMPULSE TYPE “1” : TON = 1.0ms, TOFF =0.5ms
STOP BIT : TFs = 1.5ms

Then the 100 ms worst case (WC) is

DC = ON TIMEWC/ 100 ms = ((1.5 + 1* 65 )/100) = 0.665

20 LOG(DC) = -3.5dB (correction factor)
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Following pictures are only for view the type of impulse.

Agilent Spectrum Analyzer - Swept SA

e icooE B : ALIGNAUTO | 03:21:38 PM May 15, 20Endlish [United States]
Marker 2 A 113.390 ms Trig Delay30.00 ms  Avg Type: Log-Pwr (LR
PNO: Fast ~+— 11ig: Video
IFGain:Low Atten: 6 dB

Select Marker’

MKR MODE TRC| $CL b

X
N N [1[¢t] 3.890 ms 58,58 dBm
2IXEEN A 113.4 ms[ (A -1.20 dB

FUMCTION FUNCTIOM WIDTH FUNCTION YALUE &

-

< > —l
msG | 1) Alignment Completed STATUS

Agilent Spectrum Analyzer - Swept SA

T e e e e i ! ALIGH AUTO 03:19:18PM
Marker 3 A 6.90000 ms Trig Delay-19.90 ms  Avg Type: Log-Pwr TrRacE [

PNO: Fast —»— 1rig: Video
IFGain:Low Atten: 6 dB Select Marker
>
3
|
1 Normal
| S
Delta
B |
Fixed[
i |
Center 433.948000 MHz
Res BW 300 kHz Ooff
MKR MODE TRC| SCL, % N FUNCTION FUNCTION WIDTH FUNCTION ¥ALUE ~

(N [1]¢] 19.80 ms £2.26 | s |

2 %all 064 d

3 A £.900 :

2 Properties>

5 I

¢ I [ ||

7 [

¢ I [

o I I More
10 I [ 10f2
11 I I I IO S N— v
: ]

MSG STATUS
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Agilent Spectrum Analyzer - Swept SA

O e e
Marker 1 17.8000 ms

Trig Delay-19.90 ms  Avg Type: Log-Pwr Marker

PNO: Fast ~—»— 1rig:Video
IFGain:Low Atten: 6 dB Select Marker
>
1
| |
Normal
VL
e
Delta
e
Fixedl>
= |
off
MKR MODE TRC| 5CL bes X FUNCTION FUNCTION WIDTH FUNCTION VaLUE
0N [1[¢t] 17.80 ms 60,66 dBm [ 020 0 0 EeEmm——ea |
Al A1 [1]t[(Ay 6860 ms| 429 dB ]
3 ] %
4 ] Properties»
[ ]
[ ]
7 ]
8 ]
9 ]
10 ]
11 I I
< >
MSG STATUS

Agilent Spectrum Analyzer - Swept SA

- I T e e

Marker 1 87.1500 ms Trig Delay60.00 ms  Avg Type: Log-Pwr
PNO: Fast —»— Trig: Video
IFGain:Low Atten: 6 dB

Select Marker’

Ref -41.00 dBm

|_n

Normal

Delta

Fixedl>

MKR MODE TRC| SCL bs v FUNCTION FUNCTION WIDTH FUNCTION WALUE A

E

Properties»

More
10of2
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5.3 Transmit behaviour after releasing the TX-button

Specify:

Base standard: | 47CFR Part 15 Section 15.231 (a)

Test requirements:

Test Setup: 47CFR Part 15 Section 15.35 (c)
RBW: 1MHz

VBW: 3MHz

Test data:

T1: 0s

T2: 687.7ms

T2-T1: 687.7ms < 5s

Comments:

The worst case is when it push rapidly the button 1 two time and immediately push the left buttons. Normally the
transmit stop immediately after the release of button.

At marker 1 the transmitter send a transmission because the button was pushed, at marker 2 the product stop
any transmission.

Ag}ient Spectrum Analyzer - Swept SA

T e ! ALIGNAUTO | 03:16:59PM May 15, 2014
Marker 1 18.3000 ms Trig Delay-20.00 ms  Avg Type: Log-Pwr

Marker

PNO: Fast ~—»— 1rig:Video
lEGali:Lau preneliE Select Marker
>
1
Ref -41.00 dBm [ E s e |
Normal
T
Delta
||
Fixedl
||
Center 433.948000 MHz Span 0 Hz
VBW 300 kHz Sweep 1.000 s (1001 pts) off
MKR MODE TRC| 5CL bes X FUNCTION FUNCTION WIDTH FUNCTION VaLUE
U N[1[t]  1830ms|  £190dBm| | | e — |
A A1 [1[ttny 00 687.7ms[(AY  520dB[ 0000 ] ]
] ] .

3 ] ] Properties>

5 ] ]

8 ] [

7 ] ] |

I ]

g ] ] More
10 ] ] 10f2
11 I I
: gl ==

MSG STATUS
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5.4 Radiated output power

Specify:

Base standard: | FCC 15.231 (b)

Test Requirements:

200Hz (f < 150kHz)

9kHz (150kHz < f < 30MHz)
120kHz (30MHz < f < 1000MHz)
1MHz (f > 1000MHz)

RBW / VBW:

Test data:

78.45dBuV/m at 3m (peak 81.95dBuVv/m) P6/U
74.46dBuV/m at 3m (peak 77.96dBuVv/m) P1/U
77.05dBuV/m at 3m (peak 80.55dBuv/m) P6S/U
76.45dBuV/m at 3m (peak 79.95dBuVv/m) P1S/U

Output radiated power (3m of distance):

76.45

Comments:

the results on this report are related to the the worst case when the product was tested on three axes (X, Y, Z)

*RBW 100 kHz Marke T
VBW 300 kHz 81.95 dBuv/m

Ref 95 dBpv/m «Att 20 dB SWT 2.5 ms 433.950000000 MHz

L.o0

oo y

= ZT N

2 ap

4
cxmm _,.f“rr
|60 P

3pB

Center 433.92 MHz 100 kHz/ Span 1 MHz

Date: 18.JUN.2014 17:02:34
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«RBW 100 kHz Marker T
VBW 300 kHz 80.55 Buv/m
Ref 95 dBuvV/m *Att 20 dB SWT 2.5 ms 433.950000000 MH=z
90
1
= —'—\
oL FW/ \.
i M’[ \1‘. s
60
tf‘ ps
LLHAJL}WW!
3pB
ac
ll I l[ l r lll l
110 I T I
.10
L0
Center 433.92 MHz 100 kHz/ Span 1 MHz
Date: 18.JUN.2014 17:16:55

«RBW 100 kHz Marker T
VBW 300 kHz 9.95 dBpV/m

Ref 95 dBuvV/m Att 20 dB SWT 2.5 ms 433.952000000 MH=z
.00
|

o0 \
2 ap |70
crrwm \ s

60 & ~

o 1 : k.
3pB

ISUnRiila

Center

Date:
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«RBW 100 kHz Ma rk T
VBW 300 kHz .9
Ref 95 dBuvV/m Att 20 dB SWT 2.5 ms D
.00
|
oo
70 /
2 ap -
crLRwR #ffﬂf
L60 i ]
Lso r I
4
30
ll[ Il'll ' l!lill [H
L 20
10
Lo
Center 433.948 MHz 100 kHz/ Span 1 MHz

Date: 13.MAY.2014 12:01:00
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5.5 Typical pulse train of a signal

Specify:
Base standard: | 47CFR Part 15 Section 15.231 (a)
Test Setup:
RBW: 1MHz
VBW: 3MHz
Test Data:
Duty-cycle 66.5%
TX on 66.5ms
TX off 33.5ms
i *
éygg?ge correction factor (20*log(duty 20 log (66.5ms / 100ms) = - 3.5dB

Comments:

See comments in clause 5.2
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5.6 Compliance with the limit of FCC
Specify:
Base standard: | 47CFRF Part 15 Section 15.231 (b)
Test Setup:
200Hz (f < 150kHz)
. 9kHz (150kHz < f < 30MH2)
RBW /VBW: 120kHz (30MHz < f < 1000MHz2)
1MHz (f > 1000MHz)

Limits:

Frequency Field Strength of the Field Strength of spurious

[MHZz] fundamental emissions
40,66 — 40,70 2 250uV/m / 67dBuV/m 225puVim [ 47dBuVim
70 -130 1 250uV/m / 62dBuV/m 125uV/m / 42dBuV/m
130-174 1 250pVv/m to 3 750uV/m @ 125uV/m to 375uV/m @
62uV/m to 71,5uV/im 42dBuV/m to 51,5dBuV/m
174 — 260 3 750uVv/im / 71,5dBuV/m 375uV/m / 51,5dBuV/m
260 — 470 3 750uV/m to 12 500uV/m @ 375uV/m to 1 250uV/m @
71,5 dBuV/m to 82 dBuV/m 51,5dBuV/m to 62dBuV/m

above 470 12 500uV/m / 82dBuV/m 1 250uV/m / 62dBuV/m

Note: @ linear interpolations

for 130 to 174MHz the interpolation is: 56,8182*f — 6136,36 (f in MHZz)
for 260 to 470MHz the interpolation is: 41,667*f — 7083,33 (f in MHZz)

Test Result:

Frequency:

Calculated average (3m of
distance):

78.45dBpVvV/m < 80.82dBuV/m P6/U
74.46dBpVvV/m < 80.82dBuVv/m P1/U
77.05dBpV/m < 80.82dBuV/m P6S/U

76.45dBpV/m < 80.82dBuV/m P1S/U

Comments:

the results on this report are related to the the worst case when the product was tested on three axes (X, Y, Z)
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5.7 Spurious emission - radiated
Specify:
Base standard: | 47CFR Part 15 Section 15.231 (b)
Test Setup:
Limits:
Frequency Field Strength of the Field Strength of spurious
[MHZ] fundamental emissions
40,66 — 40,70 2 250uV/m / 67dBuV/m 225pV/m / 47dBuVim
70-130 1 250uV/m / 62dBuV/m 125uV/m / 42dBuV/m
130- 174 1 250uVv/m to 3 750uV/m @ 125uV/m to 375uV/im @
62uV/m to 71.5uV/im 42dBuV/m to 51.5dBuV/m
174 — 260 3 750uVv/m / 71.5dBuV/m 375uV/m / 51.5dBuV/m
260 — 470 3 750puV/m to 12 500uV/m M 375uV/m to 1 250uV/m @
71,5 dBuV/m to 81.9 dBuV/m 51,5dBuV/m to 61.9dBuV/m
above 470 12 500uV/m / 81.9dBuV/m 1 250uV/m / 61.9dBuV/m
Note: @ linear interpolations
for 130 to 174MHz the interpolation is: 56,8182*f — 6136,36 (f in MHZz)
for 260 to 470MHz the interpolation is: 41,667*f — 7083,33 (f in MHZz)
Model P6/U
Test Result:
Peak Average Limit maximum .
Frequency Amplitude of | Amplitude aII_owgd t?(itualfattenuatlonf Result
[MHZz] emission of emission emission elow frequency o esults
(dBpuV/m) (dBuV/m) power operation (dB)
(dBuV/m)
433.950 81.95 78.45 80.82 2.37 operating frequency
867.894 48.79 45.29 61.9 16.61 complies
1301.820 49.19 45.69 54.0 8.31 complies
1735.495 52.60 49.10 61.9 12.80 complies
2170.115 50.26 46.76 61.9 15.14 complies
2603.355 44.65 41.15 61.9 20.75 complies
3037.635 46.97 43.47 61.9 18.43 complies
3471.595 46.79 43.29 61.9 18.61 complies
3907.930 45.94 42.44 54.0 11.56 complies
4338.815 46.11 42.61 54.0 11.39 complies
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Model P1/U
Test Result:
Peak Average Limit maximum .
Frequency Amplitude of | Amplitude aII_owgd t,f\citualfattenuatlonf Result
[MHz] emission of emission emission elow frequency o esults
(dBpV/m) (dBpV/m) power operation (dB)
(dBuV/m)
433.952 77.96 74.46 80.82 6.36 operating frequency
867.922 53.11 49.61 61.9 12.29 complies
1301.737 42.87 39.97 54.0 14.03 complies
1735.886 43.51 40.01 61.9 21.89 complies
2169.690 53.35 49.85 61.9 12.05 complies
2605.314 43.32 39.82 61.9 22.08 complies
3037.633 58.73 55.23 61.9 6.67 complies
3471.582 52.94 49.44 61.9 12.46 complies
3905.391 47.92 44.42 54.0 9.58 complies
4341.885 45.91 42.41 54.0 11.59 complies
Model P6S/U
Test Result:
Peak Average Limit maximum _
Frequency Amplitude of | Amplitude allpwgd t,)AcltuaIfattenuanonf Result
[MHZ] emission of emission emission elow frequency o esults
(dBpV/m) (dBpV/m) power operation (dB)
(dBuV/m)
433.950 80.55 77.05 80.82 3.77 operating frequency
867.888 47.46 43.96 61.9 17.94 complies
1301.570 42.46 38.96 54.0 15.04 complies
1735.875 51.17 47.67 61.9 14.23 complies
2169.905 44.72 41.22 61.9 20.68 complies
2604.260 44.01 40.51 61.9 21.39 complies
3037.325 46.29 42.79 61.9 19.11 complies
3471.295 45.62 42.12 61.9 19.78 complies
3907.750 45.83 42.33 54.0 11.67 complies
4341.380 46.43 42.93 54.0 11.07 complies
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Model P1S/U
Test Result:
Peak Average Limit maximum .
Frequency | Amplitude of | Amplitude aII_owgd t,f\citualfattenuatlonf Result
[MHz] emission of emission emission elow frequency o esults
(dBpV/m) (dBpV/m) power operation (dB)
(dBuV/m)
433.952 79.95 76.45 80.82 4.37 operating frequency
867.913 53.98 50.48 61.9 11.42 complies
1301.917 40.67 37.17 54.0 16.83 complies
1735.816 48.44 44.94 61.9 16.96 complies
2169.670 53.85 50.35 61.9 11.55 complies
2601.809 44.08 40.58 61.9 21.32 complies
3037.613 59.27 55.77 61.9 6.13 complies
3471.622 51.43 47.93 61.9 13.97 complies
3905.881 47.74 44.24 54.0 9.76 complies
4338.495 45.37 41.87 54.0 12.13 complies
Comments:
The results on this report are related to the worst case when the product was tested on three axes (X, Y, Z)

Report nr.

0241aFCC1

Nice S.p.A. Oderzo TV ltalia

page

25/38

tel. +39.0422.853838

date:

2014-06-30

www.niceforyou.com



http://www.niceforyou.com/

FCC test report

5.8 Occuped bandwith

Specify:

Base standard: | 47CFR Part 15.231 (c)

The bandwidth of the emission shall be no wider than 0,25% of the center frequency for devices operating above
70MHz and below 900MHz. For devices operating above 900MHz, the emission shall be no wider than 0,5% of
the center frequency. Bandwidth is determined at the points 20dB down from the modulated carrier.

Test Setup:

RBW: 3kHz
VBW: 10kHz
Limits:

< 0,25% of the centre frequency, here 1,08MHz

Test Data:

348kHz P6/U
354kHz P1/U
300kHz P6S/U
298kHz P1S/U

Occupied bandwidth at —20dB:

Comments:

Reportnr. 0241aFCC1 page 26/38 date: 2014-06-30

Nice S.p.A. Oderzo TV ltalia tel. +39.0422.853838 www.hiceforyou.com



http://www.niceforyou.com/

Nice

FCC test report

6

Measurement and Test Equipment instrumentation

Manufacturer Serial number Celleiabt:aaz]:)n el iDer‘?ation
ANA 7 Agilent N9020A MY48011101 19/03/2014 | 19/03/2015
ANA | 12 ggmzé‘ FSL3 102039
ANA | 13 monde & FLS3 101359 11/04/2013 | 11/04/2016
ANT 1 EMCO 3;&? 9312-901
ANT 3 Schwarzbeck VULB9160 3180 13/06/2013 | 13/06/2015
ANT 4 AH System SAS-571 684 13/06/2013 | 13/06/2015
ANT 5 AH System SAS-562B 236 06/06/2011 | 06/06/2015
ANT 6 AH System SAS-571 1025 13/06/2013 | 13/06/2015
ANT 7 Aaronia BicoLOG 30100 1293 13/06/2013 | 13/06/2015
ANT 9 Schwarzbeck VHBA 9123 525 13/06/2013 13/06/2015
ATT 1 - PE7021-6 21/06/2011 | 21/06/2015
ATT 2 Tyco 50WCW .

Electronics Co.
ATT 5 RADIALL R414.710.000 -
ATT 6 RADIALL R414.710.000 -
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ATT 7 RADIALL R414.720.000 -

CAV 1 Rohde & HFU2-75 ; 18/09/2013 | 18/09/2015
Schwarz

CAV 2 Rohde & HFU2-z4 - 18/09/2013 | 18/09/2015
Schwarz

CAV 3 TESEO CAVO A - 18/09/2013 | 18/09/2015

CAV 5 TESEO CAVO C - 18/09/2013 | 18/09/2015

CAV 6 TESEO CAVO D - 18/09/2013 | 18/09/2015

CAV 7 TESEO CAVO E - 18/09/2013 | 18/09/2015

CAV 13 TESEO CAVO G - 18/09/2013 | 18/09/2015

CAV 14 TESEO CAVO H - 18/09/2013 | 18/09/2015

CAV 15 TESEO CAVO | - 18/09/2013 | 18/09/2015

CAV 16 Rohde & 9111505/200 (CAVO 5995-12-161-6890 | 18/09/2013 | 18/09/2015
Schwarz J)

CAV 17 Nice CAVO K - 18/09/2013 | 18/09/2015

CAV 18 Nice CAVO L - 18/09/2013 | 18/09/2015
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CAV 19 Nice Cavo M - 18/09/2013 | 18/09/2015
CAV 20 Nice Cavo N - 18/09/2013 | 18/09/2015
CAV 21 Nice Cavo P - 18/09/2013 | 18/09/2015
CAV 22 Nice Cavo R - 18/09/2013 | 18/09/2015
CDN 1 FCC FCC 80;&?2'16” 5024 13/06/2013 | 13/06/2015
CDN 2 FCC FCC 801-M3-16A-S 5032 13/06/2013 | 13/06/2015
CDN 3 FCC FCC801-150-50 CDN 05031 & 05032
CDN 4 FCC FCC 801-M1-16A 7035 13/06/2013 | 13/06/2015
CDN 5 FCC FCC 801-150-50- 07113 & 07114
CDN
NSA 29/04/2013 | 29/04/2015
EN 55022 CISPR 16-1-4 14/04/2009 | 14/04/2019
CSA 1 TESEO EN 610004.3
EN 61000-4-3 06/09/2013 | 06/09/2014
ECL 1 FCC F-2031-23 466 13/06/2013 | 13/06/2015
ECL 2 FCC F-203I-CF-23MM 445
GEN 7 Rohde & SML 03 102178 20/02/2014 | 20/02/2016
Schwarz
GEN 8 Agilent N5182A MY48180288 23/09/2013 | 23/09/2014
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LIS Rohde & ESH2-Z5 100183 13/06/2013 | 13/06/2015
Schwarz

PAS FCC F-202 197 11/06/2012 | 11/06/2016

POW Rohde & NRVD 101221 12/02/2014 | 12/02/2016
Schwarz

POW Rohde & NRV-Z5 100314 14/02/2014 | 14/02/2016
Schwarz

POW Rohde & NRV-Z5 100315 14/02/2014 | 14/02/2016
Schwarz

RIC Rohde & ESCI 100140 26/02/2014 | 26/02/2015
Schwarz

SOF Rohde & EMC32 V8.53.0
Schwarz
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7
Photographic Documentation

8.1 EUT Identification
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8.2 Test Set-up
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Annex 1

Site Validation

FEDERAL COMMUNICATIONS COMMISSION

Laboratory Division
7435 Oakland Mills Road
Columbia, MD 21046
May 17, 2013
Registration Mumber: 771316
NICE S.p.A.
Via Pezza Alta, 13,
Oderzo, 31046
Traly
Attention: Enrico Campion, Mr.
Re: Measurement facility located at Via Pezza Alta, 13 - I-31046 Oderzo
Anechoic chamber (3 meter)
Date of Renewal: May 17, 2013
Dear Sir or Madam:

Your request for renewal of the registration of the subject measurement facility has been received. The information
submritted has been placed in your file and the registration has been renewed. The name of your organization will
remain on the list of facilities whose measurement data will be accepted in conjunction with applications for
Certification under Parts 15 or 18 of the Commission's Rules, Please note that the file must be updated for any
changes made to the facility and the registration must be renewed at least every three years.

Measur::mmﬂ facilities that have indicated that they are available to the public to perform measurement services on a
fee basis may be found on the FCC website www.foc.gov under E-Filing, OET Equipment Authorization Electronic

Filing, Test Firms,

Industry Analyst
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